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Introduction

This reports summarises the activities of a field mission to the Cook Islands from 1 December to 10
December 1999. It describes the main points of the setup of a Global Positioning System (GPS) base
station and its related activities. The work was carried out on a special request brought forward to
SOPAC by the Ministry of Works, Energy and Physical Planning (MOWEPP) (SOPAC Database
Task No. CK 00.001).

Acknowledgement

SOPAC would not have been able to successfully complete this task without the strong commitment
from MOWEPP, ie by Mr Atatoa Herman, Secretary of MOWEPP, and Mr Ben Parakoti, Director of
Rarotonga Water Works. SOPAC would also like to thank the staff of the Water Works, particularly
Patrick Tangapiri and Adrian Teotahi, for their enthusiasm.

Invaluable support was received throughout the project from Mr. Robyn Tan from the original
equipment supplier, SAGEM Australasia Pty Ltd.

History of the MOWEPP Global Positioning System

In 1997, MOWEPP purchased a GPS supported field asset management system manufactured by
ASHTECH and delivered by SAGEM Australasia Pty Ltd Australia Ltd through an AIDAB grant. The
system was originally intended to be used to facilitate water catchment delineation by the Lands and
Survey Department of MOWEPP. From the moment of delivery many things seemed to go wrong and
it appeared that even up to the point where SOPAC was approached by the Department of Water
Works to repair and set up the equipment, Lands and Survey still had difficulties establishing and fully
utilising the GPS. In October 1999 the Director of the Department of Water Works, Mr. Ben Parakoti,
finally assumed responsibility and approached SOPAC with the request to rehabilitate the GPS system
for MOWEPP. His initiative and the very good application possibilities of the GPS system to the water
sector in the Cook Islands resulted in the setup of the system in his department. By doing this it is
hoped that clear responsibilities of water work staff members as well as their strong ties with SOPAC
will ensure the ongoing operation and availability of the GPS system.

GPS Equipment

In 1997 the Department of Lands and Survey purchased the following equipment and software
packages:

• SCA-12 Surveyor S/N: SW01255

• SCA-12 Surveyor S/N: SW01254

• Husky FS/2 S/N: 4000031443

• Prism Software

• Prism key: KE01249

• Reliance Software.
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The equipment also included one radio transmitter and a radio receiver to allow for Real Time
Differential Correction (RTDC) of the GPS signal plus all required cables and connectors.

The inventory check of the equipment sent to SOPAC in November 1999 showed that all present
hardware parts were in good working conditions and still operational. However, the radio receivers
could not be connected to the GPS receivers and power could not be supplied to them due to missing
battery chargers and connectors. It is believed that these parts are either still with the Department of
Lands and Survey or have gone missing.

More severe problems were encountered with the available software and its set up on the GPS
receivers and the handheld controller (Husky FS/2). The Prism software that is needed for the survey
control facilities could not be installed on computers due to some unknown problems. Additionally the
handheld controller had been tempered with and needed re-booting and a subsequent rebuild. Similar
problems occurred with the GPS receivers. All necessary software was downloaded from the
ASHTECH Internet Site or provided by SAGEM Australasia Pty Ltd.

The system was conditioned so that field asset management (FAM) tasks could be successfully
completed to within decimeter accuracy.1 All options are available and software has been upgraded to
its newest available option. The respective manuals have been provided to MOWEPP in electronic
form. All necessary software has been stored onto a Water Works computer and backed up on CD
ROM in the Ministry as well as SOPAC. The survey control option, ie the Prism software needs
upgrading. This is available but at a price. MOWEPP needs to decide whether they want to rehabilitate
this option.

                                                

1 The system can accurately determine position down to centimeter-accuracy if the respective option has been built into the
system (and paid for).



3

[MR361 - Schölzel]

GPS Installation

Base station location

One of the SCA-12 receivers has been installed and configured as a GPS base station in the main
office of the Department of Water Works. At this location it is under permanent and skilled
supervision of a trained surveyor. By doing this it is hoped that the GPS system will be permanently
available and operational. Figure 1shows the general location of the base station.

Figure 1: Base station location on Rarotonga, Cook Islands

Figures 3 to 5 show the installation and the equipment in more detail.

Location of base
station at MOWEPP
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Figure 2: Office installation of the base station setup, battery chargers and cable racks.

Figure 3: Base station antenna and radio link (not yet operational) for Real Time Differential
GPS
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Figure 4: Typical rover set up for Field Asset Management (FAM) surveys

Figure 5: PC linked to the base station for post processing of the field data at the Water Works
office at MOWEPP
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Base station setup

In order to permanently set up the base station at MOWEPP final coordinates had to be established for
the installation point. This was achieved by a control survey where one receiver was placed at a known
point and the rover placed at the point where the base station was to be established. For additional
control the rover was also placed on a second known point to get a feel for the accuracy of the newly
established point. Known coordinates for Bolt A and Bolt A2 have been provided by Lands and
Survey Department and were established during a High Accuracy Survey for the Cooks Islands by a
New Zealand agency. Figure 6 explains the principle.

Figure 6: Principle of establishing a base station using known points

Table 1 lists the position of the two known points and the established (corrected) coordinates applying
Differential GPS.

Table 1 : Known and measured position for the base station setup

Name Easting Northing H.a.s.l Datum Zone Comments

Bolt A 417006.635 7655370.780 2.567 m WGS 84 UTM 4, South Temp base station, position
known

Bolt A2 417027.188 7655388.306 2.536 m WGS 84 UTM 4, South Control point, position known

New Base 414159.390 7653698.560 5.5 m WGS 84 UTM 4, South To be established base
station, measured

Point at MOWEPP
where the base station
will be established
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The measured and known coordinates for Bolt A2 have been listed in Table 2. The overall vector
inaccuracy is less than 7 cm. Since the point where the base station is to be established is at a distance
of merely 3000 m from the known control point (Bolt A2) it can be assumed that the same magnitude
of inaccuracy applies to the “New Base” point. Hence Table 1, row 3 states a very good approximation
of the coordinates for the base station at MOWEPP.

Table 2: Measured and known position for Bolt A2

Known Position Measured Position

Name Easting Northing H.a.s.l Easting Northing Difference

Bolt A2 417027.188 7655388.306 2.536 m 417027.25 7655388.34 < 7 cm

However, a second control survey was carried out to double-check the base station coordinates. The
base station has been set up and the rover moved to the known points Bolt A and Bolt A2 while the
measured position for the “New Base” point was used for the differential correction of the rover data.
Figure 7 describes the principle.

Figure 7: Principle of double checking the established base station position by measuring GPS
position on two known points
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The comparison between the GPS positions for the two known points Bolt A and Bolt A2 with the
known position showed that the inaccuracy lay within the decimeter accuracy of the ASHTECH
Differential GPS. The position for the base station at MOWEPP can therefore be accepted as stated in
Table 3 and Table 1, row 3.

Table 3: Base station coordinates at MOWEPP Water Works office

Name Easting Northing H.a.s.l Datum Zone Comments

New Base 414159.390 7653698.560 5.5 m WGS 84 UTM 4, South To be established base
station, measured
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Appendix 1: Step by step GPS Manual

This manual does not replace nor dispense with the original manuals.

A. Base Station Setup

Get started

Make sure that the batteries are fully charged before you connect them to the base station. Then
you need not worry about power setup at all.

1. Connect handheld to Base Station

2. Switch on handheld

3. Start Reliance Program on handheld

• Type “R” and then “Yes” button

• Press any button, the Reliance Main Screen appears

• Press “F4” to access Setup Screen
Simply check whether a Session has been specified, the default name is “Basefile”

 DO NOT CHANGE IF SESSION NAME IS ALREADY “BASEFILE”

• If session has been altered for some reason reset it to “Basefile” and press F4 for OK.
(You can disregard the Feature File for the base station.)

• If you haven’t done so yet return to the Main Screen. If you don’t know how to do that put
the handheld aside and ask for assistance.

Base station receiver initialisation

You should be at the main screen now.

1. Press F3 (or GIS). The GIS menu appears.

2. Press Shift and then F2 (or RCVR). The receiver setup appears. Do not alter the screen at this
stage.

3. Press Shift and F2 (RSET). The receiver reset screen appears. Press F2 to clear memory2.

4. Once it has finished press F4 (or RETN) to go to the next screen. You should now be at the
receiver setup screen.

                                                

2 (In fact that should not be necessary for the receiver has a rollover memory. However, it helps keeping your information
easier to administrate.)
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5. Press Shift and F1 (or FILE) to access the file management screen. There should be only one file
now called BASEFILE. If not think before doing anything else, preferably you should repeat Step
2.

• While you are watching the file management screen the File Size should slowly increase
because the receiver is logging data.  If there is only one file press F4. You should now be at
the receiver setup screen again.

6. Press F4 again . You should now be at the GIS main menu.

7. Press F4 again. You should now be at the Main Screen.

Power Setup: The following step is optional and simply increases convenience

1. From the main screen press Shift and F2 (or BATT)

• If you’re sure that the batteries are full enter:

• 4600 mAh

• 100 %

• 12.8 V

• 15 % into the respective fields.

2. That’s it. Press F4 (or OK). The bar level should change after a short period.

3. On this screen you should find the following items:

FAMlog

POWER:  ON Session: Basefile

The relevant bars should show updated levels after a short period of time.

You are done now with the base station setup.

You can access the Reliance program now by pressing Shift and  F4  (or EXIT). Press Y to leave the
program. The base station should be up and running. You should now turn to the (base station)
receiver and watch the light. After the red flush several short green flashes should appear.

If no lights flash at all the base station is down and you have to repeat the procedure. However,
check whether batteries are connected and fully charged. If there are no green lights flashing

following the red light the receiver can’t connect to satellites. Check whether the antenna has been
connected (or not stolen or damaged).
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B. Rover Setup

You need to follow these instructions each time you plan to have a field survey.

Get packed and out in the field

This step assumes that you have successfully downloaded the required feature file for the Field Asset
Management trial on to the handheld. If you have not yet done so, do it now.

Note that your file names might be different from the ones this manual uses!

For this example we will require the feature file VALVE.FDF out of the feature directory in the
Reliance folder (see Office Procedures).

Now check that:

• the rover batteries are fully charged and connected to the receiver

• the handheld batteries are fully charged

• you use the bipod with a fixed height. The standard height is 2.035 m but may vary depending on
your current use of rods. However, make sure that you do not have to change the antenna height
during the survey

• you take a notebook to make some notes for this particular survey

• the base station is running

• you are relaxed and sober.

1. It is a good idea to setup the rover while you are still in the office. In order to do so connect the
batteries to the receiver and connect the handheld.

2. Switch the handheld ON.

3. Start Reliance Program on handheld

• Type “R” and then “Yes” button

• Press any button, the Reliance Main Screen appears

• Press “F4” to access Setup Screen

Note:

While you are doing this the handheld may beep and display warning messages. That is because the
receiver can’t connect to satellites (because you are still in the office, of course). You can ignore

these messages.

4. Specify a Session. The suggestion is that you call it DAYddmm where ddmm is the date.
Assuming you do your survey on the 9th of December the session name should be DAY0912.
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5. Once you have entered the session name press F1 (or FDF) to load the right feature file for your
survey. The handheld will display the available feature files. Select the desired file, in this case
VALVE.FDF and press F4 (or OK). The session setup screen now shows the session name and the
selected feature file. Press F4 again to return to the main screen.

Setup Rover for Data Collection

You should be at the main screen now.

1. Press F3 (or GIS). The GIS menu appears.

2. Press Shift and then F2 (or RCVR). The receiver setup appears. Enter the following values into the
fields:

• PDOP Mask: 6

• Antenna Height: 2.035 m. Please note that this value might be different depending on your
seup.

• Elevation Mask: 10

• Data to log: Code and Carrier (Never, never alter this value)

3. Press Shift and F2 (RSET). The receiver reset screen appears. Press F2 to clear memory3.

• Once it has finished press F4 (or RETN) to go to the next screen. You should now be at the
receiver setup screen.

4. Press Shift and F1 (or FILE) to access the file management screen. There should only be one file
now called DAY0912 (as an example, because you may have entered a different date). If not think
before doing anything else, preferably you should repeat bullet point 3 (receiver reset). While you
are watching the file management screen the File Size should slowly increase because the receiver
is logging data.  If there is only one file press F4. You should be now at the receiver setup screen
again.

5. Press F4 again, you should be now at the GIS main menu.

6. Now press F3 (or LGST) to get to the Data Logging setup screen. Enter 2 seconds for the interval
and a convenient time on point, eg 2 min (you may increase or decrease that value but not to less
than 1 minute). Enter 4 for the min. kinematic SV’s.

7. Press F4 to return to the GIS Main Menu.

8. Press Shift F2 again

9. Press F4 again. You should now be at the Main Screen.

Power Setup: The following step is optional and simply increases convenience

1. From the main screen press Shift and F2 (or BATT)

• If you’re sure that the batteries are full enter:

                                                

3 (In fact that should not be necessary for the receiver has a rollover memory. However, it helps keeping your information
easier to administrate.)



13

[MR361 - Schölzel]

• 4600 mAh

• 100 %

• 12.8 V

• 15 % into the respective fields.

2. That’s it. Press F4 (or OK). The bar level should change after a short period.

• On this screen you should find the following items:

FAMlog

POWER:  ON Session: DAY0912

The bars should show updated levels after a short period of time.

3. You are now ready to roll and leave the office.

Do not switch off handheld or receiver. Do not access the program. Simply pack your stuff and
move to the first point intended for data collection.

Out in the field

1. Move to your first point of data collection. It is good idea to collect some data for a known point
in order to have some means of accuracy control at the end of the survey. However, this is not
imperative.

2. The handheld may have switched off while transiting. Use the red button to switch on again. You
should be on the Reliance Main Screen now. The receiver should be still running.

3. Setup the bipod with antenna. After a short while you should get satellite data indicated through
green flashes at the receiver.

4. If you are on the main screen press F3 (or GIS). Once your equipment has been setup properly on
the spot press F2 (or FEAT) to start collecting data.

5. Use the cursor buttons to select the correct feature (Area, Line or Point). In this particular case a
feature called Valve should appear. Select it and press either “yes” or F4 (or LOG). The Screen
changes telling you that the receiver is logging data. It also tells how many attributes for this
feature have to be entered.

6. Now select the right attribute by using the cursor buttons. Once you have selected it press “Yes”.
Submenus may appear. If so, select the right sub-attribute and press “Yes”. Keep pressing the
“Yes” button of the handheld until you are prompted to enter the next values for the attribute.
While you’re doing all this a counter at the button counts “the time on point” down. Once it has
finished it will chime.
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The receiver has been set to “time on point’ of 2 min or so. That might prove inconvenient if you
feature line or area data. Set the desired value while you are in the office, never ever change these

values while in the field on a survey.

7. You should now have collected your first point data. Move to the next point and repeat Step 4 of
this part of the manual. Follow the instructions on the screen as described.

Do not switch off receiver or exit reliance on the handheld for coffee, lunch or tea break or any
other necessary or unnecessary break. Go to step 5 of this part of the manual (finished data

collection) once you are done for the day.

You have finished data collection in the field

Once you collected all data for the day perform the following steps:

1. Depending on where you currently are perform:

2. From the Point: Logging screen hit F4 (DONE or F3 QUIT)

3. From the “Select Feature Screen” press F3 (or QUIT)

4. From the GIS Main Menu press F4 (RETN)

5. From the Main Screen you can access the Reliance program now by pressing Shift and  F4  (or
EXIT). Press Y to leave the program. The rover should be down now.

6. Return home and drive carefully. Do not drink before or when driving.
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C. Office Procedures to Post Process your Data

Loading a feature file to the handheld

If you are sure that the right feature file is already on the handheld go to step 2 of this part of the
manual.

1. Connect the handheld to the PC. You have to use the single black cable. Plug it into COM 1 of the
PC.

2. Switch the handheld ON (red button).

3. On the PC start the Reliance program

The following screen appears:
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4. Now select the project that holds the Feature File you intend to use. Assuming your project is
called WatValve.prj you select the the respective file from the OPEN Menu. After you have done
that you should have the following scrren:

5. From the Project Control Menu

select “Transfer Data”. The following screen dispalys:



17

[MR361 - Schölzel]

6. Now select Transfer information between the PC and the handheld device” by clicking the upper
most button to the right. You should see the following screen:

7. Switch the handheld ON if you haven’t done so yet and type: HCOM and then press “yes” on the
handheld. The handheld shows single screen. Click OK at the PC screen. You should see a similar
screen after a brief period of time on the PC:

Please note that your actual screen may look different from the one displayed because you may
have created lots of files and different directories.

8. If you find that the desired feature file is already on the handheld exit the screens and resume
STEP 2 of the manual. If not, select the directories within the PC frame that hold the feature file
you wish to install. In this example the desired file is in C:\RELIANCE\PROJECTS\FEATURE.
That is the default directory for feature files. The file to download is called Valves.fdf.
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9. Select the file and press the little arrow. After a short period the screen should change to
something like that:

meaning that the relevant file has been transferred to the handheld. At the same time the handheld
should show a message indicating that it has received a file.

You can now end the Reliance Program after you saved your files. Press ESC on the handheld to
exit the HCOM program. You should have successfully downloaded the feature file onto the

handheld; congratulations!
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Downloading the field data and base station data from the receivers

Download Data from Rover

This part of the manual assumes that you have performed all previous parts of this manual, ie collected
some data.

1. Connect the handheld to the PC. You have to use the single black cable. Plug it into COM 1 of the
PC.

2. Switch the handheld ON (red button).

3. On the PC start the Reliance program

The following screen appears:
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4. Now select the project you intend to work on. You can also create a new project for one particular
Field Asset Management project. Use the “New” command in the “File” menu. Assuming your
project is called WatValve.prj you select the the respective file from the OPEN Menu.

5. After you have done that you should see the following screen:

6. From the Project Control Menu

select “Transfer Data”. The following screen displays:
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7. Select “Download GPS data from the GPS receiver. Assuming you have the rover receiver
connected you’ll see a screen similar to this one:

Note that your window will appear after a short period of time and will have some files available for
downloading. Ideally you should have an Almanac (don’t download), a Waypoint file (extension

.wdf, don’t download), a Feature file (extension .fdf, don’t download) and only one rover file
(ideally again) with a name like DAYddmm.s01 (if you followed the suggested name convention)

where ddmm is the date and the xtension “.s01” indicates how many files for the rover session have
been created4.

8. Select the relevant rover file , set the path to the desired directory (it is recommended that you stick
to the default directories unless you feel familiar with the system.). Get file information to make
sure you are going to download the right file then click “Begin”. The file will be copied onto your
PC.

Note that “downloading will not delete or remove the file from the receiver!

                                                
4 Assuming you do your survey on the 9th of December the session name should be DAY0912.s01!!!
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Download Data from Base Station

1. Repeat bullet points 1 to 7 of the “Download Data from Base Station” section but with the base
station connected to the PC. On the “Download” form

set the Path to the base station directory and proceed.

Note that your window will appear after a short period of time and will have some files available for
downloading. Ideally you should have an Almanac (don’t download), a Waypoint file (extension

.wdf, don’t download), a Feature file (extension .fdf, don’t download) and only one base station file
(ideally again) with a name like Bcccca00.ddd  where “cccc” are the first letters of your base station

session setup, “00” indicates the year when the file has been created  and the extension “.ddd”
indicates the day of the year the file has been created.

9. Select the relevant base station file , set the path to the desired directory (it is recommended that
you stick to the default directories unless you feel familiar with the system.). Get file information
to make sure you are going to download the right file then click “Begin”. The file will be copied
onto your PC.

Note that “downloading will not delete or remove the file from the receiver!

You are now ready to process your data!!
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Processing your field data

This part of the manual assumes that you have performed all previous parts of this manual, ie collected
and downloaded some data.

1. Connect the handheld to the PC. You have to use the single black cable. Plug it into COM 1 of the
PC.

2. Switch the handheld ON (red button).

3. On the PC start the Reliance program

The following screen appears:

4. Now select the project you intend to work on. You can also create a new project for one particular
Field Asset Management project. Use the “New” command in the “File” menu.
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Assuming your project is called WatValve.prj you select the the respective file from the OPEN
Menu.

5. After you have done that you should see the following screen:

6. From the Project Control Menu

select “Project Setup”. The following screen displays:
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7. Choose the tab “Map System” to set up your projections etc. Set all parameters so that they match
with the following screen print:
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8. Now select the “Session Settings” tab and select the options so that they match with the following
screen. Please note the extensions of the base station file and the rover file. The names on your
screen will be different but according to your input under sessions when you set up the rover and
base station receiver. Also note that each button that opens files will look up files in the default
directories as defined in the “Directories” tab.

Of course files will be only present if you’ve downloaded them from the receiver prior to the setup.

Before you click OK make sure that the “Use Average Base Position” box is not ticked and the base
station coordinates entered as given above or in Table 3.

9. Now click OK. You will see some windows that will disappear very quickly before the “Project
Control” form appears again.
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10. You are know ready to view the data involved in Session 1 (or whatever name you assigned to it.
Also note that this session name has got absolutely nothing to do with your session name when
you set up the rover). Click “View Data” and you should see a screen similar to this one:

If for some reason the files do not overlap you know there’s something wrong.

Action: Check whether you’ve included the correct files into the session. You should not (and you
can’t) process data that does not overlap. The worst case now is that your filed data has been

incorrectly sampled. You are in deep trouble and may have to repeat the data collection.

11. If the views look similar to the one above you may review the data. Refer to the Reliance Office
Manual for details on the “Time View” and “Map View” window.

12. You can now process the data. Close the “Time View” and “Map View” window and choose
“Process Data” from the “Project Control” form. The following screen appears:
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13. Select “Decimeter” and “2-Sigma Filter” and click “Begin”. The following screen will appear for
the time the data processing takes.

14. Afterwards the previous screen will look like the following:

the only difference being a small asterix beside the session name that has been processed.

15. Close the screen and select “Data View” from the “Project Setup” form. The “Time View” and
“Map View” reappear the difference being that the data has been differential-corrected now and
the positions should be accurate down to a decimeter and better.

 You’re now ready to use this data in the Geographical Information System of your choice.
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Exporting Data to your GIS

Please note that it is assumed that the projection system has been setup to WGS 84, UTM Zone 4,
South as described earlier on in this manual. Please seek competent advice if you are not sure what
that means.

1. From the “Project Control” form choose “Export Data”

2. Select “Map Info (*mif) as the file format and enter a name.

3. Select the directory where the file should be created. Select from the “Individual Feature Files”
Menu as appropriate. (Make sure the filters in Reliance have been correctly set.)

4. Click “Save” to create the file.

5. Open MapInfo and import the “.mif”-file through the Table>Import menu.

6. You need to create points and lines as appropriate in MapInfo before you can view the data. You
can, however, browse it without further processing.



30

[MR361 - Schölzel]

Appendix 2: GPS Glossary

Anywhere fix

The ability of a receiver to start position calculations without being given an approximate location and
approximate time.

Bandwidth

The range of frequencies in a signal.

C/A code

The standard (Course/Acquisition) GPS code. A sequence of 1023 pseudo-random, binary, biphase
modulations on the GPS carrier at a chip rate of 1.023 MHz. Also known as the "civilian code."

Carrier

A signal that can be varied from a known reference by modulation.

Carrier-aided tracking

a signal processing strategy that uses the GPS carrier signal to achieve an exact lock on the pseudo random
code.

Carrier frequency

The frequency of the unmodulated fundamental output of a radio transmitter.

Carrier phase GPS

GPS measurements based on the L1 or L2 carrier signal.

Channel

A channel of a GPS receiver consists of the circuitry necessary to receive the signal from a single GPS
satellite.

Chip

The transition time for individual bits in the pseudo-random sequence. Also, an integrated circuit. Also a
snack food. Also a betting marker.

Clock bias

The difference between the clock's indicated time and true universal time.

Code phase GPS

GPS measurements based on the pseudo random code (C/A or P) as opposed to the carrier of that code.

Control segment

A world-wide network of GPS monitor and control stations that ensure the accuracy of satellite positions
and their clocks.

Cycle slip

A discontinuity in the measured carrier beat phase resulting from a temporary loss of lock in the carrier
tracking loop of a GPS receiver.
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Data message

A message included in the GPS signal which reports the satellite's location, clock corrections and health.
Included is rough information on the other satellites in the constellation.

Differential positioning

Accurate measurement of the relative positions of two receivers tracking the same GPS signals.

Dilution of Precision

The multiplicative factor that modifies ranging error. It is caused solely by the geometry between the user
and his set of satellites. Known as DOP or GDOP

Dithering

The introduction of digital noise. This is the process the DoD uses to add inaccuracy to GPS signals to
induce Selective Availability.

Doppler-aiding

A signal processing strategy that uses a measured doppler shift to help the receiver smoothly track the GPS
signal. Allows more precise velocity and position measurement.

Doppler shift

The apparent change in the frequency of a signal caused by the relative motion of the transmitter and
receiver.

Ephemeris

The predictions of current satellite position that are transmitted to the user in the data message.

Fast switching channel

A single channel which rapidly samples a number of satellite ranges. "Fast" means that the switching time is
sufficiently fast (2 to 5 milliseconds) to recover the data message.

Frequency band

A particular range of frequencies.

Frequency spectrum

The distribution of signal amplitudes as a function of frequency.

Geometric Dilution of Precision (GDOP)

See Dilution of Precision.

Hardover word

The word in the GPS message that contains synchronization information for the transfer of tracking from the
C/A to P code.

Ionosphere

The band of charged particles 80 to 120 miles above the Earth's surface.

Ionospheric refraction

The change in the propagation speed of a signal as it passes through the ionosphere.
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L-band

The group of radio frequencies extending from 390 MHz to 1550 MHz. The GPS carrier frequencies
(1227.6 MHz and 1575.42 MHz) are in the L band.

Multipath error

Errors caused by the interference of a signal that has reached the receiver antenna by two or more different
paths. Usually caused by one path being bounced or reflected.

Multi-channel receiver

A GPS receiver that can simultaneously track more than one satellite signal.

Multiplexing channel

A channel of a GPS receiver that can be sequenced through a number of satellite signals.

P-code

The Precise code. A very long sequence of pseudo random binary biphase modulations on the GPS carrier at
a chip rate of 10.23 MHz which repeats about every 267 days. Each one week segment of this code is unique
to one GPS satellite and is reset each week.

Precise Positioning Service (PPS)

The most accurate dynamic positioning possible with standard GPS, based on the dual frequency P-code and
no SA.

Pseudolite

A ground-based differential GPS receiver which transmits a signal like that of an actual GPS satellite, and
can be used for ranging.

Pseudo random code

A signal with random noise-like properties. It is a very complicated but repeating pattern of 1's and O's.

Pseudorange

A distance measurement based on the correlation of a satellite transmitted code and the local receiver's
reference code, that has not been corrected for errors in synchronization between the transmitter's clock and
the receiver's clock.

Satellite constellation

The arrangement in space of a set of satellites.

Selective Availability (SA)

A policy adopted by the Department of Defense to introduce some intentional clock noise into the GPS
satellite signals thereby degrading their accuracy for civilian users.

Slow switching channel

A sequencing GPS receiver channel that switches too slowly to allow the continuous recovery of the data
message.

Space segment

The part of the whole GPS system that is in space, i.e. the satellites.
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Spread spectrum

A system in which the transmitted signal is spread over a frequency band much wider than the minimum
bandwidth needed to transmit the information being sent. This is done by modulating with a pseudo random
code, for GPS.

Standard Positioning Service (SPS)

The normal civilian positioning accuracy obtained by using the single frequency C/A code.

Static positioning

Location determination when the receiver's antenna is presumed to be stationary on the Earth. This allows
the use of various averaging techniques that improve accuracy by factors of over 1000.

User interface

The way a receiver conveys information to the person using it. The controls and displays.

User segment

The part of the whole GPS system that includes the receivers of GPS signals.


